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To insert an image:

1. Click on the Pictures icon in the Insert tab

2. Select your image

To resize an image:

1. Click on the image

2. Go to the Format tab

3. Click on Crop

4. Cropping handles will appear. Click, hold and 

drag a handle to crop the image.

5. Centre the image by clicking, holding and 

dragging it to the centre of the box. 

N.B. To crop the image proportionally, hold the Shift 

key while you resize the image.

To replace an image displayed:

1. Delete the image displayed

2. Click on the Pictures icon

3. Select a new image

14.10.25 3
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Présentation générale du contrat
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✓ Vous avez été notifié pour être partenaire Ecomaison concernant votre déchetterie professionnelle

✓ Les flux notifiés et les options associées sont indiqués sur les notifications, les flux non notifiés ne peuvent être 
réceptionnés gratuitement au titre du contrat Ecomaison

✓ Les flux notifiés sont activés par le biais du paramétrage sur le SI Ecomaison. Si pas de paramétrage sur le SI 
c'est que le flux n'est pas activé, par ex autres DEA (rembourrés)

✓ La durée du contrat : le contrat peut être prorogé deux fois pour des durées de 1 (une) année. L’échéance 
des deux prorogations atteint au maximum la date du 31/03/2029

Date de début de contrat = date de la notification

Le contrat déchèterie professionnelle
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Rappels des options de réponse par flux

RECEPTION TRANSPORT TRAITEMENT

Prestataire

Prestataire ECOMAISON

2 options de gestion par flux (choix flux par flux)

Option 1
Prestation complète

Option 3
Collecte seule

Accueil, contrôle 

de l'apport, 

traçabilité, 

rechargement le 

cas échéant

Transport pour 

livraison sur un site 

préparation ou 

massification

Préparation et 

recyclage ou 

valorisation 

énergétique

Option 2 : 
arrêtée
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Exclusivité des flux ou non : deux modes de gestion

Vous avez un contrat exclusif 

Ecomaison sur les flux notifiés

Vous n’avez pas de contrat exclusif avec 

Ecomaison sur les flux notifiés

Options possibles 1 ou 3

Attention si vous contractualisez en cours 

de marché avec un autre éco-organisme 

sur les mêmes flux, vous devrez passer en 

option 1 obligatoirement et vous êtes tenus 

de nous informer de cette 

contractualisation dans les meilleurs délais

Traçabilité des entrées Utilisation de l’application ourecycler obligatoire

Paiement des sorties
Paiement sur les sorties via le SI

(réception a minima en option 3 et en option 1 transport, traitement également)
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Gestion opérationnelle en fonction des options

Option 1 Option 3

Modalités du 
contenant

Liberté sur le contenant 
mise à disposition

Alvéole, benne, bacs,...

Contenant non logoté

Selon le choix d'Ecomaison
avec son prestataire de collecte

Contenant logoté

Mélange des 
flux

Mélange avec d'autres 
flux

Aucun mélange possible

Transport
A votre charge et selon 

vos modalités avec votre 
exutoire

A la charge d'Ecomaison ainsi que l'exutoire
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Les professionnels détenteurs de déchets disposant d'un véhicule de moins de 
7,5 tonnes PTAC :

➢ Professionnels du bâtiment, artisans,...

➢ Les collecteurs de déchets des professionnels

Si un apporteur dispose d'un contenant, il lui appartient de le vider selon les 
consignes sur votre site (exemple : les déchets conditionnés en big bag doivent 
être vidés du contenant) et la reprise du contenant n'est pas comprise dans la 
REP PMCB/DEA/ABJ/J (pas de reprise gratuite)

Qui est apporteur ?



14.10.25 9

➢ Des visites opérationnelles vont être planifiées par les équipes 
régionales Ecomaison

➢ Votre site est audité tous les 2 ans

Visites et audits Ecomaison



To insert an image:

1. Click on the Pictures icon in the Insert tab

2. Select your image

To resize an image:

1. Click on the image

2. Go to the Format tab

3. Click on Crop

4. Cropping handles will appear. Click, hold and 

drag a handle to crop the image.

5. Centre the image by clicking, holding and 

dragging it to the centre of the box. 

N.B. To crop the image proportionally, hold the Shift 

key while you resize the image.

To replace an image displayed:

1. Delete the image displayed

2. Click on the Pictures icon

3. Select a new image

14.10.25 10

02
Les consignes de tri et les 
outils de communication



Produits sous périmètre 
Ecomaison admis

11



• Déchets non inertes du bâtiment + DEA + ABJ + Jouets

Reprise gratuite des déchets mobiliers, bâtiment, jouets et bricolage-jardins

= uniquement s’ils sont triés et tracés dans l’application (pas de reprise d'un flux en 
mélange)

= votre site doit disposer de la notification Ecomaison pour le flux concerné

Quels sont les déchets admis en dépôt gratuit ?

12

bois

inertes
sauf terre

menuiserie 
vitrée

métaux plastiques
Plâtre 

sans complexe

• Déchets inertes du bâtiment

Non contractualisés avec Ecomaison

Vous pouvez contractualiser avec

• Hors 
amiante, 
déchets 
travaux 
public, 
emballages, 
D3E, articles 
de sports et 
loisirs



Déchets de bois issus de l’activité bâtiment, mobilier, jouets et bricolage-jardins : bois traités en 
surface dont chutes, poutre, planche, portes, plancher/parquet, charpente, chevrons, plinthes …, 
panneaux en bois (cloisons, contreplaqués, particules, fibres, OSB ), huisseries bois hors vitrage, 
charpentes, bois terrasse, meubles de cuisine…

• Les bois traités « non dangereux » (peinture, vernis ou lasures, …), les bois recouverts de papier peint 
et les bois avec inserts métalliques sont acceptés.

Bois
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X Déchets non admis 
Déchets d’emballages (Tourets, palettes, cagettes)

Déchets de coffrages

Déchets de bois altérés ou pourris

Déchets de bois traités avec des substances dangereuses 
(créosotés)

Bois alvéolaire, dalle en fibre de bois

Traitement 
Valorisation énergétique (combustion) en  

chaudière biomasse 

Recyclage dans la fabrication de 

nouveaux objets ou panneaux en bois

DÉCHETS ET MATERIAUX ADMIS ET FILIERES DE TRAITEMENT

14.10.25



Menuiseries vitrées 

DÉCHETS ET MATÉRIAUX ADMIS DANS LES ESPACES DE COLLECTE

Fenêtres et baies vitrées : ouvrants double et simple vitrage, châssis aluminium, acier, PVC et bois. Vitrage 

intègre et sécurisé. Dormants acceptés lorsqu’ils ne sont pas séparés de la fenêtre.
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Ouvrants Ouvrants Ouvrants 

X Déchets non admis 
Si les dormants sont séparés de la fenêtre, ils doivent être 
stockés dans les contenants relatifs aux matériaux 
constitutifs

Verre photovoltaïque

Déchets dangereux (peinture au plomb, joints amiantés)

Tout déchet de parois vitrées non intègres : vitrage cassé

Traitement 
Valorisation matière (après 

démantèlement des matériaux 

constitutifs) dans la fabrication 

de nouveaux produits ou 

énergétique
14.10.25



Métaux ferreux et non ferreux 

DÉCHETS ET MATÉRIAUX ADMIS DANS LES ESPACES DE COLLECTE

Sont considérés comme déchets métalliques, si 65% en masse du déchet est du métal 

Déchets métalliques ferreux de l’activité bâtiment, mobilier, jouets et bricolage-jardins  : treillis, équerres, balcons, 

dalles de plafond, outillages à main en métal, raccords de canalisation sanitaires, profilés, structures porteuses 

(IPN)…

Déchets métalliques non ferreux : raccords de canalisation sanitaires, bardages, huisseries sans vitrage 

Ferraille Laiton Cuivre Aluminium
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X Déchets non admis 
Déchets métalliques relatifs à la filière REP 
DEEE

Déchets dangereux dont métaux revêtus 
avec peinture au plomb

Traitement 
Valorisation matière par refonte des métaux 

(industrie sidérurgique ou fonderie) en vue de 

créer de nouveaux produits métalliques

14.10.25



Balle de films 

plastiques

Plastiques

DÉCHETS ET MATÉRIAUX ADMIS DANS LES ESPACES DE COLLECTE

Déchets de plastique souple ou rigide issus de l’activité bâtiment, mobilier, jouets et bricolage-jardins

Tout type de résine et principaux produits en résine souple ou rigide : PVC, PP/PE, Polyuréthane (PUR)…
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X Déchets non admis 
Déchets d’emballage: films souples 

Présence de colle et de ragréage

Revêtements de sol PVC multimatériaux, moquettes et autres 
revêtements de sol textiles, revêtements de sol caoutchouc, sols 
durs…

Planchers techniques et bardage extérieurs en HPL (stratifié haute 
pression)

Panneaux exclusivement PU et mousses PU

Isolants en PSE et XPS, membranes bitumineuses

Toiles enduites (bâche piscine, écran de façade, toiture tendue…), 
toile et fibre de verre, sous-couches, bandes d’étanchéité…

Traitement 
Valorisation matière dans la fabrication de 

nouveaux produits plastiques en substitution 

de résine vierge (après transformation et 

préparation) 

Valorisation énergétique après préparation 

en Combustible Solide de Récupération 

(CSR)
14.10.25



Plâtre simple (qualité 2)

Déchets de plâtre issus de l’activité Bâtiment (secs): plaques de plâtre standard / hydrofuges 

(vertes) / phoniques (bleues) / feu (roses) / haute dureté (jaune), dalles de plafond en plâtre, 

cloisons alvéolaires, carreaux de plâtre, corniches et moulures en staff non fibré
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X Déchets non admis 
Plaques de plâtre associées à de l’isolant (polystyrène, 
laine minérale, …)

Plaques de plâtre renforcées avec de la cellulose

Staff, stuc

Briques plâtrières, déchets de béton, plaques ciment

Sac de poudre de plâtre, colle à base de plâtre

Traitement 
Recyclage dans la fabrication de 

plaques de plâtre ou dans l’industrie 

cimentière

Plaques de plâtre Carreaux de plâtre Plaques et carreaux de plâtre

DÉCHETS ET MATERIAUX ADMIS ET FILIERES DE TRAITEMENT

14.10.25



Outils de communication
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Entrée / Accueil

Affiche A3 parcours client 
à poser à l’accueil

Banderole 3x1 m à poser à l’entrée  

Variante au format 
panneau 80x120 cm

(sur demande à valider 
sous 1 mois après la 

date de notification)

14.10.25

Fournie au format digital

Livrée dans le kit de communication

OU



Signalétique bennes

Panneaux de flux à poser à proximité de chaque contenant – Fournis au format digital 

14.10.25



Communication client

Dépliant 4 pages format plié A5 – Livré dans le kit de communication (400 exemplaires) + Fourni au format digital

14.10.25



To insert an image:

1. Click on the Pictures icon in the Insert tab

2. Select your image

To resize an image:

1. Click on the image

2. Go to the Format tab

3. Click on Crop

4. Cropping handles will appear. Click, hold and 

drag a handle to crop the image.

5. Centre the image by clicking, holding and 

dragging it to the centre of the box. 

N.B. To crop the image proportionally, hold the Shift 

key while you resize the image.

To replace an image displayed:

1. Delete the image displayed

2. Click on the Pictures icon

3. Select a new image

14.10.25 22

03
La gestion des entrées via ourecycler



14.10.25 23

Quelques éléments

✓ Si les flux sont conformes aux consignes de tri, sont notifiés et activés par Ecomaison, nous 
vous invitons à proposer la gratuité du dépôt à l’artisan et au pro même s’il ne connaît pas 
l'application ourecycler

✓ La facturation du dépôt se fera alors entre vous et Ecomaison

✓ La saisie dans l'application est faite par flux en poids par vos soins suite pesée = il vous 
suffit du mail et SIRET de l’artisan pour valider son apport, pas besoin qu’il ait auparavant 
créé son compte sur ourecycler

✓ Vous pouvez faire la promotion de l’application pour que l’artisan prépare son dépôt
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Une interface adaptée sur mobile et PC pour organiser la prise en charge des 

déchets ainsi que la traçabilité

Un même portail pour les apporteurs de déchets et pour les espaces de 
collecte

Des tunnels utilisateurs distincts :

o Pour les professionnel/artisans qui apportent leurs déchets

o Pour le point de collecte qui acceptent les déchets

Une cartographie pour permettre d’identifier les points de collecte et les flux 
repris gratuitement

https://ourecycler.ecomaison.com (depuis un navigateur et non pas sur les stores)

Application Ecomaison : faciliter le dépôt et la prise en charge 

14.10.25

Accessible 
sur mobile 
et sur PC



Focus sur la pesée

25
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Plusieurs flux PMCB avec pesée par flux

1. Application 
renseignée avec 

les poids des 
différents flux 
concernés et 
dépôt validé

2. Pesées par flux sur 
votre logiciel interne

3. Faire une extraction 
des données de votre 

logiciel interne par flux et 
déclarer les tonnages à 

Ecomaison lors des 
sorties sur le SI Collecte 
(logiciel Ecomaison), 

conserver les justificatifs

A faire à chaque dépôt
A faire à chaque 

envoi vers l’exutoire
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Extraire les données de l’application

1. Se connecter à l’application 
avec vos identifiants point de 

collecte

2. Sur la page d’accueil, 
cliquer ici pour télécharger les 

bons de pesées validés 



MODOP de 
l'application pour les

PROS / ARTISANS

28



To insert an image:

1. Menu insertion

2. Cliquer sur “images”

3. Sélectionner son image

To resize an image:

1. Cliquer sur l’image

2. Puis menu “format de l’image”

3. Cliquer sur “rogner”

4. Les curseurs de rognage vont apparaitre. Cliquer, 

puis maintenir et ensuite deplacer les curseurs

afin de rogner l’image.

5. Centrer l’image en cliquant, maintenant et en

deplacant l’image au centre du Mockup.

N.B. Maintenir shift en cliquant sur les angles avant de 

redimensionner l’image pour ne pas alterer le format.

To replace an image displayed:

1. Supprimer l’image déja en place

2. Clquer sur le menu image

3. Selectionner une nouvelle image

Profil PROS / ARTISANS : utiliser l'application (gratuit)

14.10.25 29

1. Ouvrir l'application sur mobile via 

l'adresse https://ourecycler.ecomai

son.com/

2. Cliquer sur "Un professionnel / un 

artisan"

3. Se connecter ou créer un compte

4. Cliquer sur "Faire un dépôt"

2

3 4

https://ourecycler.ecomaison.com/
https://ourecycler.ecomaison.com/


To insert an image:

1. Menu insertion

2. Cliquer sur “images”

3. Sélectionner son image

To resize an image:

1. Cliquer sur l’image

2. Puis menu “format de l’image”

3. Cliquer sur “rogner”

4. Les curseurs de rognage vont apparaitre. Cliquer, 

puis maintenir et ensuite deplacer les curseurs

afin de rogner l’image.

5. Centrer l’image en cliquant, maintenant et en

deplacant l’image au centre du Mockup.

N.B. Maintenir shift en cliquant sur les angles avant de 

redimensionner l’image pour ne pas alterer le format.

To replace an image displayed:

1. Supprimer l’image déja en place

2. Clquer sur le menu image

3. Selectionner une nouvelle image

14.10.25 30

5. Sélectionner le(s) déchet(s) à déposer

6. Evaluer la quantité, le tonnage et pour les 

huisseries possibilités d’indiquer des 

tonnages ou unités

7. Enregistrer

REPETER LES OPERATIONS 5, 6 et 7 AUTANT DE 

FOIS QUE VOUS AVEZ DE DECHETS 

DIFFERENTS A DEPOSER LORS DU MEME 

DEPOT

5

6

7

Profil PROS / ARTISANS : utiliser l'application (gratuit)

m3
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8. Géolocaliser votre position

9. chercher le point que vous souhaitez

10. Cliquer alors sur "Sélectionner ce 

point"

8

9

10

Profil PROS / ARTISANS : utiliser l'application (gratuit)
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11. Renseigner les informations de 

votre entreprise (SIRET obligatoire, 

autres informations non obligatoires)

12. Cliquer sur "Suivant"

13. Renseigner les informations sur 

votre chantier et cocher la case des 

CGU après les avoir lues

14. Cliquer sur "Envoyer"

15. Le bon de dépôt est créé et a été 

envoyé par mail

Profil PROS / ARTISANS : utiliser l'application (gratuit)

11

12

13

14

15

➢ Même mode opératoire sur PC
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MODOP de 
l'application pour les
POINTS DE COLLECTE



To insert an image:

1. Menu insertion

2. Cliquer sur “images”

3. Sélectionner son image

To resize an image:

1. Cliquer sur l’image

2. Puis menu “format de l’image”

3. Cliquer sur “rogner”

4. Les curseurs de rognage vont apparaitre. Cliquer, 

puis maintenir et ensuite deplacer les curseurs

afin de rogner l’image.

5. Centrer l’image en cliquant, maintenant et en

deplacant l’image au centre du Mockup.

N.B. Maintenir shift en cliquant sur les angles avant de 

redimensionner l’image pour ne pas alterer le format.

To replace an image displayed:

1. Supprimer l’image déja en place

2. Clquer sur le menu image

3. Selectionner une nouvelle image

Profil POINT DE COLLECTE : utiliser l'application 1/5

14.10.25 34

1. Ouvrir l'application sur mobile ou 

pc via 

l'adresse https://ourecycler.ecom

aison.com/

2. Cliquer sur "Un point de collecte"

3. Se connecter

4. Cliquer sur "Contrôle de 

dépôt" ou créer le 

bordereau de dépôt à la 

place de l’artisan via son 

mail et SIRET

5. Scanner le QR code de l'artisan 

ou renseigner le code à 6 chiffres

32
4

https://ourecycler.ecomaison.com/
https://ourecycler.ecomaison.com/
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Profil POINT DE COLLECTE : utiliser l'application 2/5

PROCEDER AU CHOIX DU MATERIAU PUIS SAISIR LE 

TONNAGE + MAIL, SIRET ET NOM DU CHANTIER
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Profil POINT DE COLLECTE : utiliser l'application 3/5

5. PROCEDER AU CONTRÔLE QUALITE DE L’APPORT

CAS OU LES DECHETS INDIQUES ET LE VOLUME 

SONT VALIDES :

6. Valider le dépôt

7. Une page de validation s’affiche, vous pouvez 

quitter l’application et faire procéder au vidage

Entreprise A

6 7
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Profil POINT DE COLLECTE : utiliser l'application 4/5

5. PROCEDER AU CONTRÔLE QUALITE DE L’APPORT

CAS OU LES DECHETS INDIQUES ET/OU LE VOLUME 
NE SONT PAS CONFORMES MAIS LES DECHETS 
RESPECTENT LE CAHIER DES CHARGES :

6. Cliquer sur :

7. Modifier le volume et/ou le type de déchet

8. Cliquer sur la flèche "<" pour revenir à la page de 
validation

9. Pour ajouter un type de déchet, cliquer sur 

"ajouter" et renseigner 7

10. Cliquer sur "Valider le dépôt"

11. Une page de validation s’affiche, vous pouvez 
quitter l’application et faire procéder au vidage

Entreprise A

6

8

7

9
11

10
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Profil POINT DE COLLECTE : utiliser l'application 5/5

5. PROCEDER AU CONTRÔLE QUALITE 

DE L’APPORT

CAS OU LES DECHETS INDIQUES NE RESPECTENT 

PAS LE CAHIER DES CHARGES :

6. Cliquer sur "Refuser le dépôt"

7. Une page vous indique que le refus a été 

pris en compte, un mail vous est envoyé ainsi 

qu'à l'artisan

Si votre site accepte le déchet refusé, vous 

pouvez procéder aux vidages selon vos 

conditions opérationnelles et tarifaires (hors de 

l'application)

Entreprise A

6



To insert an image:

1. Click on the Pictures icon in the Insert tab

2. Select your image

To resize an image:

1. Click on the image

2. Go to the Format tab

3. Click on Crop

4. Cropping handles will appear. Click, hold and 

drag a handle to crop the image.

5. Centre the image by clicking, holding and 

dragging it to the centre of the box. 

N.B. To crop the image proportionally, hold the Shift 

key while you resize the image.

To replace an image displayed:

1. Delete the image displayed

2. Click on the Pictures icon

3. Select a new image

14.10.25 39

04
La gestion des sorties vers les exutoires



To insert an image:

1. Menu insertion

2. Cliquer sur “images”

3. Sélectionner son image

To resize an image:

1. Cliquer sur l’image

2. Puis menu “format de l’image”

3. Cliquer sur “rogner”

4. Les curseurs de rognage vont apparaitre. Cliquer, 

puis maintenir et ensuite deplacer les curseurs

afin de rogner l’image.

5. Centrer l’image en cliquant, maintenant et en

deplacant l’image au centre du Mockup.

N.B. Maintenir shift en cliquant sur les angles avant de 

redimensionner l’image pour ne pas alterer le format.

To replace an image displayed:

1. Supprimer l’image déja en place

2. Clquer sur le menu image

3. Selectionner une nouvelle image

Prérequis

14.10.25 40

✓ Vous avez pesé les entrées et les sorties via votre logiciel de pesées

✓ Vous avez validé les entrées dans l'application (sur mobile ou sur PC)

✓ Vous allez saisir différentes opérations sur les sorties en fonction de l’option 
définie selon le flux sur le SI Collecte : https://extranet-operateursdechets.eco-
mobilier.fr/

https://extranet-operateursdechets.eco-mobilier.fr/
https://extranet-operateursdechets.eco-mobilier.fr/
https://extranet-operateursdechets.eco-mobilier.fr/
https://extranet-operateursdechets.eco-mobilier.fr/
https://extranet-operateursdechets.eco-mobilier.fr/


14.10.25 41

Les prestations sont payées sur le principe des tonnes sortantes

Soit les tonnes envoyées dans l’exutoire (option 1)

Soit les tonnes livrées sur un site désigné par Ecomaison ou transférées sur le marché 
logistique Ecomaison (option 3)

Les tonnes sortantes ne peuvent être supérieures aux tonnes entrantes

Sur ce marché, la saisie des entrées se fait sur l’application 
www.ourecycler.ecomaison.com, les entrées ne sont pas à enregistrer dans le SI 
Ecomaison

Il est demandé de mettre en place un suivi des entrées par flux en tonnage

Des contrôles de cohérence sont mis en place pour vérifier la cohérence des entrées 
déclarées dans l’application et les sorties

Des contrôles sur site seront effectués pour s’assurer de la gestion des flux et des 
déclarations

Des justificatifs pourront être demandés lors de l’envoi des factures ou lors des audits

Principes de la facturation

http://www.ourecycler.ecomaison.com
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FACTURATION OPTION 1

C'est la saisie en exutoire qui déclenche le paiement des 
prestations : collecte (réception) + transport + traitement
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Comment faire sur mon site ?

Cas 1 : pour le flux désigné, je ne mélange pas les apports Ecomaison avec d’autres 
apports. Ces apports, s’ils sont conformes aux consignes de tri, ne sont pas facturés.

Cas 2 : pour le flux désigné, les apports des partenaires Ecomaison sont mélangés 
avec des apports d’autres clients, que je facture.

= alors je mets en place un suivi des tonnages apportés au titre d’Ecomaison, pour 
déterminer le tonnage mensuel à déclarer à Ecomaison pour la facturation (quote part) 

Option 1 : gestion complète d’un flux par le prestataire (1/2)
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2. Saisie des opérations

A chaque fois que j’envoie mon flux vers l’exutoire, je saisis sur l’Extranet d’une opération 
d’Exutoire

Je choisis le flux concerné puis je saisis le tonnage total envoyé vers cet exutoire après pesée, 

Cas 1 (100% Ecomaison) : j’indique le même tonnage sur la ligne « quote-part Ecomaison » 
qui sera facturée

Cas 2 (Mélange) : je saisis le tonnage total envoyé vers cet exutoire après pesée, et j’indique 
le tonnage sur la ligne « quote-part Ecomaison » qui sera facturée.

Je m’assure que sur un mois, le tonnage « quote-part Ecomaison » soit inférieur ou égal au 
tonnage réceptionné sur le mois 

J’édite le bordereau de transport et je le fais signer par l’exutoire

J’archive le bordereau et le bon de pesée correspondant

A noter : il est possible de faire 1 opération mensuelle d’exutoire avec la somme des tonnages 
envoyés en exutoire. Dans ce cas, il faudra un bordereau signé avec le tonnage mensuel + la 
totalité des bons de pesée du mois.

   

Option 1 : gestion complète d’un flux par le prestataire (2/2)
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Option 1 : gestion complète d’un flux par le prestataire (2/2)

3. Facturation

En fin de mois, je vais dans le « Récapitulatif des opérations »

Dans l’onglet « Opérations à valider » je vérifie les dates, les tonnages, je fais les 
modifications éventuelles. Quand tout est correct, je valide les opérations.

Dans l’onglet « Validation de l’annexe » je télécharge l’annexe définitive.

J’édite ma facture conformément au montant de l’annexe et je l’envoie par mail à 
factures.partenaires@ecomaison.com  

Je joins un extrait du registre ou du fichier de suivi des entrées, la copie des 
bordereaux de transport des envois en exutoires et les bons de pesées par mail.

   

mailto:factures.partenaires@ecomaison.com
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Option 1 : gestion complète d’un flux par le prestataire 
Saisir une opération d’exutoire (1/3)

1

2

3

1. Dans le menu Opérations, sélectionner « Exutoires »
2. Cliquer sur « Nouvel exutoire »
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3. Remplissez les champs « Lieu de 
départ » et « Type de déchet ». Indiquez si 
vous êtes le transporteur

4. Vérifiez les coordonnées de l’exutoire

5. Renseignez les informations de livraison

6. Indiquez le tonnage total expédié en 
exutoire et le tonnage des flux Ecomaison 
(quote-part).

Option 1 : gestion complète d’un flux par le prestataire 
Saisir une opération d’exutoire (2/3)



Option 1 : gestion complète d’un flux par le prestataire 
Saisir une opération d’exutoire (3/3)

5. L’opération est créée. Cliquez sur la ligne pour accéder au détail de l’opération.

6. Cliquez sur « Générer le bordereau de transport ». Le bordereau prérempli est généré en PDF. 

Un exemplaire devra être remis au site pour signature. Vous devrez laisser un exemplaire et en 

récupérer un, qui sera à conserver.

5

6
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Récapitulatif des opérations

1. Allez dans le menu « Récapitulatif des opérations »

2. Dans l’onglet « Opérations à traiter », finalisez la 

saisie des opérations en cours (état brouillon)

3. Dans l’onglet « Validation de l’annexe », 

sélectionnez les lignes à facturer en les cochant

4. Cliquez sur « Valider »

5. Téléchargez le brouillon d’annexe pour une 

vérification.

6. Téléchargez l’annexe définitive.

1

2 3

3

4
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FACTURATION OPTION 3

C'est la saisie en « Nouvel enlèvement pro » ou « Transfert » vers le 
marché LOGISTIQUE qui déclenche le paiement des prestations 

collecte (réception)
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Comment faire sur mon site ? 

Un site logistique désigné par Ecomaison, titulaire d’un marché A (logistique) ou un site titulaire du 
marché Huisseries a mis un contenant à disposition sur mon site

Lorsque le contenant est plein, je fais une demande de Transport Pro sur l’Extranet

Le contenant est enlevé, remplacé par un contenant vide

1. Saisie des opérations

Sur l’extranet je saisi une opération « Enlèvement pro » 

Je choisis le flux à collecter

Je saisis la date souhaitée pour l’enlèvement

L’opérateur de collecte confirme le créneau d’enlèvement > la demande passe au statut « pris en 
charge »

L’enlèvement est effectué; l’opérateur de collecte saisit le tonnage pesé en entrée sur son site. Ce 
tonnage servira de base au paiement des prestations de réception.

Option 3

A/ collecte seule avec enlèvement pro
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3. Facturation

En fin de mois, je vais dans le « Récapitulatif des opérations »

Dans l’onglet « Opérations à valider » je vérifie et fais les modifications éventuelles. Quand tout est 
correct, je valide les opérations.

Dans l’onglet « Validation de l’annexe » je télécharge l’annexe définitive.

J’édite ma facture conformément au montant de l’annexe et je l’envoie par mail à

 factures.partenaires@ecomaison.com    

   

Option 3

A/ collecte seule avec enlèvement pro

mailto:factures.partenaires@ecomaison.com
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Option 3

A/ collecte et transport d’un flux par le prestataire 
Saisir une opération d’enlèvement pro (1/2)

1

2

3

1. Dans le menu Opérations, sélectionner « Enlèvement pro »

2. Cliquer sur « Nouvel enlèvement pro »



3. Le cas échéant, sélectionnez le flux devant faire l’objet d’en enlèvement. Les informations du lieu de livraison 

apparaissent.

4. Renseignez les dates et horaires souhaités pour l’enlèvement. Prévoir minimum 1j de délai pour toute demande 

avant 12h (du lundi au vendredi). 

5. Cliquez sur « Enregistrer »

L’opération est créée au statut ouvert. Lorsque le collecteur aura confirmé son créneau d’enlèvement elle passera 

au statut « Prise en charge ». Et lorsque le contenant aura été réceptionné et le poids saisi dans l’Extranet, elle 

passera au statut final « Traité ».

5

6

Option 3
A/ collecte et transport d’un flux par le prestataire 
Saisir une opération d’enlèvement pro (2/2)

4

14.10.25 54
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Pour les flux bois, plastique, ferraille uniquement = si je suis aussi titulaire du marché logistique je dois 
transférer les tonnes du marché Déchèterie pro vers le marché logistique sur le SI

Option 3

B/ collecte seule avec transfert vers marché logistique
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Échéances pour la facturation

Les conditions de règlement sont : 45 jours fin de mois
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ecomaison.com

contact@ecomaison.com

Contactez-nous (appel gratuit)

0 801 908 108

Ecomaison
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